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Requirements 

What you need: 

 Atari ST, MegaST, STe, MegaSTe, Falcon030 or TT030 or 

faster Atari-compatible. Supported Operating Systems: TOS 

1.4 and above, MagiC, MiNT and Geneva. Memory required: 

4 MB or more (larger filesystems may require up to 16 MB). 

 ExtenDOS 4 (DVD/CD driver software by Anodyne Software). 

 a compatible DVD/CD recording device (please refer to the 

ExtenDOS 4 documentation for a list of currently supported 

DVD/CD Recorders and how to connect them to your 

computer). 

 blank discs suitable for your recording device: 

CD-R (CD-Recordable) 

CD-RW (CD-ReWritable) 

DVD-RW (DVD Re-Recordable) 

DVD-R (DVD Recordable) 

DVD + R (DVD Recordable) 

For simplicity, in this manual we use the term disc to 

designate any of the above types of discs. Note that 

DVD+RW, DVD-RAM and double-layer (DL) discs are not 

supported. 

 a large hard disk drive partition to hold the temporary image 

file. The image file holds the files and folders to be written to 

a disc, in one session. An image file of approximately 700 MB 

is required to fill an 80 minute CD. The maximum supported 

session size is 2 GB, which will only partially fill a DVD. 

However, since CD InScriptOr supports multiple sessions, 

you do not need to fill the entire disc at one time. 
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Overview 

When it starts up, CD 

InScriptOr automati-

cally opens a new 

Session window, as 

shown here. 

This window is used to 

list the folders and files 

that you want to write 

to a disc. This list can 

be saved in a session 

(.CDI) file so that you 

can use exactly the 

same list at a later date. 

See the Session window 

section to explore its features. 

Once you are satisfied with the contents of your session and 

wish to write it to a disc, choose the Write... item from the 

CD/DVD menu or click the CD/DVD icon. This will open the 

Write dialog box. See the Write dialog box section below. 

You can write multiple sessions to the same disc, until it's full. 

Creating a multi-session disc is simply a matter of writing to a 

disc that was already written to. By default, CD InScriptOr is set 

up so that the operating system will see all the files of all the 

sessions on a disc. If a file to be written already exists in a 

previous session, it will be re-written only if it changed. 

You can set and save various preferences via the Options menu. 

The most commonly-used options are found in the General 

Options window; other options are in the Advanced Options 

window. The Drive Options window allows you to specify which 

of your disk drives should be used as the Image drive, and (if you 

have more than one recorder) which recorder to use. The 

Exclusion Options window specifies files and folders you want 

to exclude from a session. These options are explained in detail 

later in this manual. 
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Write dialog box 

The Write dialog box is 

opened by clicking on the 

CD/DVD icon in the 

Session window, by 

pressing Control-W on 

the keyboard or from the 

CD/DVD menu by choosing 

the Write... item.  

When the Write dialog box 

is displayed, and you are ready to write, insert a disc in the 

recorder device. 

Volume ID 

Type a name for your session. The name, referred to as the 

Volume ID or label, is often used by desktops for display below 

of drive icons. Valid characters are letters, numbers and the 

space character. Spaces will be replaced by underscores (_) on 

the disc. 

From image file 

Instead of creating a disc from the current session window, you 

can write the disc from an existing image file. Clicking on the 

From image checkbox will bring the file selector, allowing you 

to choose an image file with the ISO extension. Long filenames 

are supported. By default, the file selector is set to your image 

drive. After selecting an image file, the filename and size in MB 

is displayed next to the checkbox. To write from an image file, 

you must use a blank disc. 

Speed 

Allows you to select the desired speed. The speeds displayed are 

adjusted according to the type of disc inserted. The controls will 

be dimmed if no disc is inserted, or if that type of disc is not 

supported (for example, if you insert a DVD+RW). The speed 
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can also be selected in the General Options window, which also 

allows the selected speed to be saved. 

Please note that the same value (e.g. 1X) does not have the same 

transfer rate for CDs and DVDs; in fact, writing to a DVD at 1 X  

requires a data transfer rate approximately nine times that 

needed for writing to a CD at 1X. 

If you've never created a disc with CD InScriptOr, or if you have 

changed your hardware setup, you will need to experiment to 

find the maximum speed at which you can record. A good way 

to find out is to select the fastest speed of your CD Recorder first. 

Do not use a DVD+R for this test. If Burnproof is available, turn 

it off (see the Drive Options section). Then try simulating. If it 

fails, select the next fastest speed, and so on. Once you have 

established your optimum speed, turn Burnproof back on if 

available. If simulating at the slowest speed fails, your optimum 

speed is the slowest speed and Burnproof must be used. 

Simulate 

We advise you to perform a simulation, before trying to write, if: 

 you are writing a disc for the first time with CD InScriptOr; 

or 

 you are using a faster recording speed than you have used 

successfully before; 

or 

 you have changed your image drive. 

Simulation does exactly the same as a real write, except that it 

does not actually turn the laser on to write to the disc. If there's 

something wrong in your setup, simulate allows you to find this 

out without wasting a blank recordable disc or having to erase a 

badly-formatted rewritable disc. 

Simulation is not supported by the DVD+R format. When a 

DVD+R disc is loaded, the Simulate button will be dimmed. 
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Note: if an error occurs during a real write to a CD-R, DVD+R 

or DVD-R, it will almost certainly be only useful as a frisbee or 

coaster, so if you have any concerns, simulate first! 

To simulate, click the Simulate button. You will be prompted if 

you wish to write the disc after a successful simulation. CD 

InScriptOr will then automatically do the following: 

1. Create a new image file (IMAGE.ISO) from the files and 

folders specified in the current session window (this file will 

also refer to the files and folders in the previous session on 

the disc, if applicable). Scanning dialogs will be displayed 

while scanning the files in the current session window (and 

while scanning the previous session, if applicable). You can 

press the Esc key while scanning to abort the entire write 

process. 

2. Simulate writing to the disc. When simulation starts, the 

mouse pointer will change to a writing hand and all dialogs 

and multitasking will be suspended. This is to ensure that 

the writing process is not disturbed, essential for a successful 

write simulation. The 'recording' light on most models of 

recorders will flash to indicate simulation. 

3. When the simulated write has completed, a simulated 

finalization phase will occur; this can take several minutes, 

particularly at a slow recording speed. After finalization is 

complete, the disc will be ejected. You can press the Esc key 

during the simulation to skip the finalization phase and end 

the process. 

4. If simulation was successful, and you have chosen to write to 

the disc after simulation, CD InScriptOr will then eject the 

disc, re-load it and write to it. The writing process is as 

described under Write below. 

Write 

Click the Write button to write to the disc. CD InScriptOr will 

then automatically do the following: 

1. Start a real write to the disc. The mouse pointer will change 

to a writing hand and all dialogs and multitasking will be 
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suspended. This is to ensure that the writing process is not 

disturbed, essential for a successful write. The 'recording' 

light on most models of recorders will remain steady. 

2. When the write has completed, a finalization phase will 

occur; this can take several minutes, particularly at a slow 

recording speed. 

3. When the finalization completes successfully, you will get a 

message indicating that the disc is ready for use, and CD 

InScriptOr will eject the disc. 

You can now load the disc into a recorder or CD/DVD drive, on 

your Atari system or another platform and access the files and 

folders on it, in the same way as a 'stamped' data disc. However, 

note that the drive you use must be capable of reading the 

physical type of disc. For example, many CD-ROM and CD-R 

drives cannot read CD-RW disks, due to the difference in 

reflectivity of the disks themselves. In contrast, CD-R disks are 

readable on almost all drives except very early CD-ROM drives. 

Tip: If your recorder supports Burnproof technology, use it to 

prevent recording errors. See the Drive Options section for details 

on how to verify that your recorder supports it and how to set it. 

Cancel 

Click the Cancel button to exit the dialog. 

Troubleshooting errors 

Try ejecting the disc and re-inserting it, then repeat the write or 

simulate. If an error occurs again, try reducing the recording 

speed, and try again. If this works, your system (computer, hard 

disk drive and/or recorder) is not fast enough for the recording 

speed you originally chose. This could also be caused by a badly 

fragmented image drive partition, in which case you will need to 

defragment it through one of the usual techniques. 

Another possible cause for errors is a bad disc blank disc; this is 

more common for DVDs than CDs: try another brand of disc. 
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If MKISOFS.PRG, the program that creates the ISO9660 file 

system, crashes or reports a "stack space exhausted" error, 

increase the stack space value in the Advanced Options window. 

Session window 

The Session window is used for building a session. A session is 

composed of files, folders and paths. These are called items. 

The title bar displays 

the current disc path; 

that is, the items 

displayed will be 

contained within 

that path when it is 

written to the disc. A 

backslash (\) on its 

own indicates that 

the items displayed 

will be written to the 

root of the disc. 

The toolbar contains 

nine buttons for easy 

access to the most 

common tasks. 

The text below the toolbar is the filename of the current session 

layout. 

The top right gadget of the window reduces the size of the 

window so that only the title bar is showing. The gadgets beside 

appear on some systems only (MagiC shown). 

The status bar normally displays the number of items in the 

current disc path. If you select one item, it displays its hard disk 

path (the source path). If you select more than one item, it 

displays the number of selected items. 

You can scroll the window up and down using the up/down 

arrows on the keyboard or those in the window. 
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Adding items 

If you have a system that supports drag and drop, you can drag 

files and folders from the desktop onto the session window. Long 

filenames are supported. Symbolic links are also supported. 

They are identified with a lower-case 'l' character in the session 

window. 

Alternatively, you can add items by clicking on the plus icon (at 

the bottom of the session window), by choosing the Add... item 

under the Edit menu, or by pressing Control-+ on the 

keyboard. This action will bring up the File Selector. Select a file 

or folder in the file selector and click OK to add the selected file 

or folder (and its contents) to the session. If you have a 

replacement File Selector that supports the Selectric/Boxkite 

interface, you can select multiple items at the same time by 

holding the Shift key while clicking on items. 

If no item is selected in the File Selector, the current path is 

added. If the current path is a folder, the folder is created. For 

example, if the current path in the File Selector is C:\, and no 

item is selected, C:\*.* is added to the session. This specifies that 

the entire contents of C are to be written to CD. As another 

example, if the current path is C:\AUTO, a folder AUTO is 

created in the session window, and it and all of the contents of 

C:\AUTO will be written to the disc. 

You can change the default behaviour of the File Selector, when 

no item is selected, and the current path is a folder (not the root). 

You can choose to create the folder, or merely add its contents to 

the current disc path. See the General Options section for setting 

this option. 

Showing files already on a disc 

You can choose to see the folders and files that are already on 

the disc, i.e. those that were written in a previous CD InScriptOr 

session. This is particularly useful when you want to add files or 

folders within existing folders on the disc, or use the folder 

structure for new discs. 
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To use this feature, insert a disc with files already on it (from a 

previous CD InScriptOr session) and then click Show files 

from the CD/DVD menu. The contents of the disc are shown. If 

the disc contains folders, you may open them. Note the 

checkmark beside each item: it indicates that the file is currently 

on the disc, and that you can't delete it. A checkmark is also 

displayed beside Show files in the CD/DVD menu. You can 

click on Show files again to remove the checkmarks beside 

the items. You won't see the files but the folder structure is kept. 

Click Show files again to see the files. 

You can save the disc's folder structure as a session file (.CDI), so 

you can use it for new discs. 

Navigating in the session 

Double-click on a folder to open it. You will see the title bar disc 

path change. You can add more items to this path if you want. 

To go up one level, click the Closer gadget (at the top left corner 

of the window). Clicking on the Closer when you are at root will 

close the session. If you haven't saved the session, you'll be 

prompted to save it at that time. 

Creating new folders 

You can create folders in your disc session that do not exist on 

your hard disk. This can be useful for organising the root of your 

disc. To create a new folder, 

click the Folder icon, or 

choose the item New 

folder... from the Edit 

menu, or press Control-F on 

the keyboard. 

A new dialog box will open, 

where you can enter the name of the new folder. Note that you 

can use long filenames and uppercase / lowercase characters. 

The vertical bars beneath the name indicate the limits of the 

standard TOS "8+3" filename format. 
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Selecting or deselecting items 

Clicking on an item selects/deselects it. You can select many 

items in one operation by holding the mouse button down, while 

moving the mouse up or down. 

If you wish to select all items in the currently displayed window, 

click the icon with four black horizontal bars, or choose the item 

Select All from the Edit menu, or press Control-A on the 

keyboard. Likewise, to deselect all items in the currently 

displayed window, click the icon with four white horizontal 

bars, or choose the item Select None from the Edit menu, or 

press Control-Z on the keyboard. 

Removing items 

First, select the items that you want to remove from the session. 

Then click the minus button, or choose the Remove item from 

the Edit menu, or press Control-- on the keyboard. You can 

press the Undo key to undo a remove if you made a mistake. 

Renaming items 

You can rename items of type folder or file. You can only rename 

one item at a time. 

To use this function, first select a single folder or file item in the 

session window. Then choose the Rename... item under the 

Edit menu, or press Control-R. A dialog box will open, where 

you can enter the new name. 

Moving items (Cut and Paste) 

You can move items to another location in your session. Select 

the items to move, then click the Scissors icon, or choose the 

Cut item under the Edit menu, or press Control-X on the 

keyboard. Then navigate in your session to the location you 

want, and click the Paste icon, or choose the Paste item under 

the Edit menu, or press Control-V on the keyboard. 
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Calculating the session size 

To calculate and display the actual size that the session will 

occupy on the disc, click the Ruler icon, or choose Display 

size from the Session menu. An external program 

(MKISOFS.PRG) will automatically run to perform this 

calculation. Since this requires examining the directory 

information for every file and folder to be written, this may take 

some time. 

The following factors will influence the size of the session: 

 Type of disc 

 ISO9660 options chosen (see General Options section) 

 Additional Systems chosen (see General Options section) 

 Contents of previous sessions on the disc 

 Contents of wildcard (*.*) paths 

If CD InScriptOr detects a disc in the recorder, it will assume 

that you want to eventually write to that disc. By default, the 

files you have specified in your session will be merged with the 

most recent session on that disc; therefore, MKISOFS.PRG will 

read the previous session in order to determine which files to 

write. If a file to be written is identical to one that already exists 

on the disc, it will not be written in the new session, and 

therefore its size will not be included in the session size. 

If no disc is detected, the displayed size will be for an empty 

disc, and will include the space for all specified files and folders. 

In either case, since the session size reflects the actual space that 

will be occupied on the disc, it will include the "session 

overhead". For CD-R and CD-RW, this is approximately 22 MB 

between the first and second session, and 13 MB between 

subsequent sessions. The 

overhead between sessions 

can be much larger on 

DVD-R(W) disks. This 

means that you may see a 

large second session size 
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reported by CDISO, even if your files don't occupy a lot of space. 

In addition to the session size, the free space that would remain 

after a write is reported, so that you know how much more data 

can be added before filling the disc. 

If the session size exceeds the disc capacity, you will be notified 

with a message indicating by how much, see example below. 

You will need to remove items or use a disc with more available 

space. 

After you click OK in the dialog 

where the size is displayed, a 

window Name changes may 

open. See the Automatic 

renaming topic below for more 

details on this window. 

If you close the Name changes window, but wish to reopen it 

later, choose the View name changes item from the Session 

menu. It will display the name changes from the most recent 

Display size or Write... action. 

Automatic renaming 

CD InScriptOr will automatically change those file and folder 

names on the disc that do not conform to the ISO9660 options 

that you have set. To find out what the new names will be, 

without writing the disc, click the Ruler icon, or choose the 

Display size item under the CD/DVD menu. This action will 

calculate the session size, as described above, but will also open 

a window titled Name changes. In this window, you can see 

which of your files will be renamed, and to what. The automatic 

renaming depends on the options that you set in the General 

Options window. 

There are three reasons that files or folders are renamed; the 

reason is listed before the name of the file, as follows: 

Translated: The original name was changed to a new name to 

conform to the options that you chose. Translated (I) indicates 

that the translation was required for basic ISO9660. Translated 

(J) indicates that the translation was required for the Joliet 
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extension information. If translation is required for both 

ISO9660 and Joliet, there will be one line for each. 

Modified: The name that would be written to the disc is the 

same as another file/folder in the same folder. This can happen 

as a result of name translations. One of the names will be 

changed: CD InScriptOr tries to minimise the changes, and to 

change the "least important" name. Modified (I) indicates that 

the change was required for basic ISO9660. Modified (J) 

indicates that the change was required for the Joliet extension 

information. If modification is required for both ISO9660 and 

Joliet, there will be one line for each. 

Relocated: The file/folder was over eight levels deep in the 

directory structure, and has been moved to a special directory 

called RR_MOVED in the root of the disc. Relocation will not 

take place if you set the option Allow more than 8 folders 

deep in the General Options window. 

Verifying items 

At any time you can verify if the items in your session still exist 

by choosing the item Verify files under the Session menu. 

You may wish to do this if you open a session that was saved 

some time ago, and you have reorganised your hard disk since. 

However, it is never necessary to do this, since CD InScriptOr 

automatically performs a validation before writing. 

If an item is not accessible, an alert will be displayed indicating 

the inaccessible item. 

Writing to the disc 

Until you get familiar with the automatic renaming and size 

requirements, we recommend that you use the Display size 

function (explained above) before writing to the disc. This 

function will tell you how much space will be used, and what 

files will be renamed and to what, so that you will not be 

surprised by the results after the disc is written. 

When you're ready to write to a disc, click the CD/DVD icon or 

choose the Write... item from the CD/DVD menu. A new 
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dialog window will open. See the Write dialog box section for 

instructions on its usage. 

Session file management 

The following options are available from the File menu: 

To save the current session, choose Save. In the file selector 

box, type in a name for your session. The default extension .CDI 

is used to identify CD InScriptOr sessions. 

To open a session, choose Open.... 

To save the current session under a different name, choose Save 

as.... 

To close the current session, choose Close or click the Close 

gadget at the upper left corner of the session window, when at 

the root (as indicated with a backslash '\' in the window title bar). 

To start a new session, choose New. 

General Options 

Choose the General... item from the Options menu to access 

the General Options window, as shown below. 
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The options in this window are described on the following 

pages. After making changes, you can click on these four 

buttons: 

Save: Saves your preferences to disk in file CDISO.INF, in the 

same folder as CDISO.PRG. This file is read every time you start 

CD InScriptOr. Your active preferences are not changed. 

OK: Sets your active preferences. 

Cancel: Cancels any changes made. 

Apply: Same as OK, but the dialog remains open. 

ISO9660 

The ISO9660 specification is more restrictive than most 

operating systems with regard to filesystem names and structure. 

This means that creating a strict ISO9660 disc even on a plain 

TOS system will normally require some changes to file and 

folder names. Fortunately, drivers that read ISO9660 discs 

(including ExtenDOS 4) usually do not require strict adherence 

to the standard in order to access the disc. Therefore, this section 

allows you to specify the most useful deviations from the 

standard, and thereby reduce the number of name changes 

required. 

Allow more than 8 folders deep: If this box is checked, 

there is no limit to the nesting of folders on the disc. If it is not 

checked, the maximum depth is eight folders, and if the session 

definition contains deeper nesting, such folders will be stored in 

the root of the disc within a special folder RR_MOVED. Any files 

or folders moved will be listed in the Name changes window as 

Relocated. 

Allow 31-character filenames: If this box is checked, the 

maximum length of file/folder names is 31 characters; otherwise 

the maximum length of filenames is governed by the standard 

TOS 8+3 format, and the maximum length of folder names is 8 

(or 8+3 if Allow '.' in folder names is checked). Any file 

or folder names changed because of these rules (except for 
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changing lower to upper case) will be listed in the Name changes 

window as Translated. 

Note: Long ISO9660 filenames are often not supported by 

ISO9660 drivers, since both the Joliet and Rock Ridge extensions 

allow long filenames as well as other features. Therefore if you 

wish to store long filenames on a disc, it is normally preferable 

to select Joliet and/or Rock Ridge, as long as the driver on the 

receiving system supports them. ExtenDOS 4 supports both Joliet 

and Rock Ridge. 

Allow non-ISO9660 characters: if this box is not checked, 

only the following characters are allowed in file and folder 

names: 

A thru Z, 0 thru 9, _ (underscore) 

Lower case characters (a-z) are translated to upper case (A-Z). If 

this box is checked, the radio buttons on the next line control the 

range of non-ISO9660 characters that are allowed. The DOS 

button allows the following additional characters: 

! # $ % & ' ( ) - @ ^ ` ~ 

The any button allows any characters at all. Any file or folder 

names changed because of these rules will be listed in the Name 

changes window as Translated. 

Allow '.' in folder names: if this box is checked, folder 

names are allowed to contain a period; otherwise they are not. If 

this box is not checked, any folder with a period in its name will 

be stored on the disc with a changed name that does not contain 

a period. Any such folders will be listed in the Name changes 

window as Translated. 

Write 

IMAGE.ISO file: Keep: When this box is selected, the image 

file, IMAGE.ISO, will not be deleted after a simulation or a write. 

If you wish to create multiple discs that are exactly the same, 

select this check box, write or simulate one disc to create the 

image file, then use the From image... item in the Write 

dialog box to create subsequent discs. Another way to create an 
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image file is to use the Make image file... item  under the 

Session menu. 

Progress bar: Limited updates: When this box is 

selected, the screen will not be updated during writing. In some 

circumstances, this may allow a successful write at a higher 

speed, but it is not normally necessary. 

Additional systems 

All discs created by CD InScriptOr are ISO9660 discs. However, 

in addition to creating an ISO9660 filesystem, CD InScriptOr can 

also create the information required by either or both of the two 

major ISO9660 extensions: Joliet and Rock Ridge. These 

extensions were invented to address perceived deficiencies in 

the original ISO9660 standard. 

Rock Ridge was created by a group of Unix-related companies to 

allow the same kind of information to be stored on a disc as is 

stored in a Unix file system; Joliet was originated by Microsoft 

mostly to support Unicode (wide character) filenames. Both 

support deep nesting of folders, long file and folder names, and 

have little or no restrictions on the characters used in names. 

One advantage of using these extensions rather than just 

'bending the ISO9660 rules' is that the extension information is 

in addition to the basic ISO9660 information. Thus it is possible 

to create a disc that conforms to the strict ISO9660 standard, 

while storing long filenames that can be read by an appropriate 

driver. 

Joliet: When this box is selected, Joliet extension information 

will be written to the disc. The maximum length of file or folder 

name allowed is 64 characters: longer names are truncated. The 

following characters are allowed in file and folder names stored 

in the Joliet extension: 

A thru Z, a thru z, 0 thru 9, space 

! # $ % & ' ( ) + , - . = @[ ] ^ _ ` { } ~  

Any file or folder names changed as a result of these rules will be 

listed in the Name changes window as Translated (J). 
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Rock Ridge: When this box is selected, Rock Ridge extension 

information will be written to the disc. There are no restrictions 

on file and folder names stored in the Rock Ridge extension. 

Note: All sessions on a multi-session disc must use the same 

additional systems. CD InScriptOr will enforce this requirement. 

You need to decide which additional system(s) to use, if any, 

before starting to write to a new disc. 

File Selector 

The behaviour of the File Selector when adding items to a 

session can be set to one of three options: 

Always: Always create a folder for the current path if no item is 

selected. 

Never: Don't create a folder, but add the contents of the current 

path if no item is selected. 

Ask: You will be prompted each time to select one of the two 

above options. 

Pre-sets 

The pre-sets are designed to help you select the proper options in 

the ISO9660 and Additional systems groups, depending on 

the operating system(s) which you intend to read the disc with. 

Clicking on a pre-set automatically sets/clears the appropriate 

options for the selected system(s). You can then modify these 

options further if you wish. The pre-set button corresponds to 

the actual options at all times. For example, if you select the pre-

set 'MagiC', then modify an option, the button text will change to 

the pre-set that matches the actual options, if there is one; 

otherwise it will display 'Custom'. 
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Exclusion Options 

You can specify items you don't want to write on disc, using the 

Exclusion Options window. This is useful when you choose 

paths and folders to write, but wish to exclude files and folders 

of a specific name or extension, or matching a pattern. For 

example, let's say your new session is composed of one item, 

C:\*.*. Normally all the content of C: will be written to disc. 

Suppose you don't want to write files with extensions TMP and 

BAK. You can specify these in the dialog. 

You can save the exclusions, so that they will be in effect for all 

the sessions you write. 

Choose the Exclusions... item from the Options menu to 

access the Exclusion Options window, as shown below. 

The top section of the window is titled Extensions to 

exclude. For example, you can enter TMP or BAK. You can 

only enter the extensions in uppercase, but lowercase and 

mixed-case extensions will also be excluded. 

The bottom section of the dialog is for specifying folders or files 

to exclude. You can type them, one per line. Note that uppercase 
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/ lowercase are different (case-sensitive). Alternatively, while the 

cursor is on a line, double-click on that line to open a file 

selector, so you can choose your folder or file. You can also type 

Unix-style wildcards, as described in Annex 2 at the end of this 

manual. 

The actual files and folders names excluded from a session will 

be displayed in the Name changes window, with lines starting 

with the word Excluded. The Name changes window is 

displayed after a write or a "display size" operation. The pattern 

that excluded the item will be specified. 

After making changes, you can click on these four buttons: 

Save: Saves your options to disk in file CDISO.INF, in the same 

folder as CDISO.PRG. This file is read every time you start CD 

InScriptOr. Your active preferences are not changed. 

OK: Sets your active preferences. 

Cancel: Cancels any changes made. 

Apply: Same as OK, but the dialog remains open. 
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Advanced Options 

Choose the Advanced... item from the Options menu to 

access the Advanced Options dialog, as shown below. 

Normally you don't need to use these advanced options. They are 

for "special purposes", for example when you want to create a 

disc for mastering. 

The options in this window are described on the following 

pages. After making changes, you can click on these four 

buttons: 

Save: Saves your options to disk in file CDISO.INF, in the same 

folder as CDISO.PRG. This file is read every time you start CD 

InScriptOr. Your active options are not changed. 

OK: Sets your active options. 

Cancel: Cancels any changes made. 

Apply: Same as OK, but the dialog remains open. 
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CD/DVD Information 

The information that you provide in this section is stored in an 

area of the ISO9660 filesystem called the Volume Descriptor. 

This information is generally not required, or even processed, by 

ISO9660 drivers on receiving systems, so it is normally left 

blank. The description for each item is a paraphrase of the 

description within the ISO9660 standard. 

Publisher: This identifies the user who specified what should 

be recorded on the disc. 

Preparer: This identifies the person or organisation that 

controlled the preparation of the data that is recorded on the 

disc. 

Abstract file name: This is the name of a file in the root 

directory of the disc that contains an abstract of the disc. 

Bibliographic file name: This is the name of a file in the 

root directory of the disc that contains bibliographic records 

related to the disc. The format of such records is not specified. 

Copyright file name: This is the name of a file in the root 

directory of the disc that contains a copyright statement for the 

disc. 

Note that if you specify an abstract, bibliographic, or copyright 

file name, you should ensure that such a file exists in the root 

directory of the disc. CD InScriptOr does not check this itself. 

Miscellaneous 

Don't include previous session: When this box is 

selected, CD InScriptOr will create a 'standalone' session, 

ignoring any existing session information on the disc in the 

recorder. This option is provided for maximum flexibility when 

creating your disc, for example when creating a CD extra disc 

(see the section How to create a CDextra disc). Except for this 

situation, we recommend that you only use this option if you are 

very familiar with the operation of the ISO9660 driver on the 

receiving system. Many receiving systems only support access to 
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the last session of a multi-session disk, and therefore selecting 

this option for a session would prevent access to the data in 

previous sessions. 

Mode 1 CD-ROM: When this box is selected, CD InScriptOr will 

create a CD using Mode 1 sectors; otherwise, it will use Mode 2 

sectors (Mode 1 and Mode 2 sectors are logically the same, but 

are recorded in a physically different way). Since Mode 2 is the 

standard for multi-session CDs, and all current CD-ROM drives 

can read both Mode 1 and Mode 2 sectors, you should normally 

not use this option. 

This choice is available for the first session you write to a CD; 

subsequent sessions will be written using the same mode as the 

first session. 

Write Protect: When this box is selected, CD InScriptOr will 

close the disc after writing the session. This means that you will 

not be able to add extra sessions to the disc. 

Don't follow symbolic links: This option only applies to 

systems that support symbolic links, i.e. MagiC and MiNT. It 

only applies to Rock Ridge. When this box is selected, only the 

symbolic links themselves will be written for the Rock Ridge 

filesystem. Otherwise, the files referred to by the symbolic links 

will be written. 

Keep file ownership and modes for Rock Ridge: 

When this box is selected, the original Posix-style userid, 

groupid and all file mode bits will be copied to the Rock Ridge 

extension on the disc, assuming that they are available on the 

filesystem that the file is coming from. 

This option was designed for users with Minix or Ext2FS 

filesystems that only plan to use the disc on the system that it 

was created on. 

You should normally leave this box unselected. The userid and 

groupid will be set to zero, and the file mode bits will be 

'rationalised' to allow access on any system. 

Stack space: This allows you to increase the stack space used 

by MKISOFS.PRG. The default of 64KB will handle most 
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situations, but for deeply-nested folders and/or long folder and 

file names, MKISOFS.PRG may terminate with a "Stack space 

exhausted" message, or even a crash. Note that increasing the 

stack space will cause MKISOFS to use more memory. 

Drive Options 

Choose the Drives... item from the Options menu to access 

the Drive Options window. In this window, you can select your 

recorder and your image drive. 

The options in this window are described on the following 

pages. After making changes, you can click on these four 

buttons: 

Save: Saves your preferences to disk in file CDISO.INF, in the 

same folder as CDISO.PRG. This file is read every time you start 

CD InScriptOr. 

OK: Sets your active preferences. 

Cancel: Cancels any changes made. 

Apply: Same as OK, but the dialog remains open. 

Choosing the recorder 

In the row labelled Recorder, choose your recorder drive letter. 

This option is only relevant if you have more than one recorder 

attached to your system. You can select the drive letter of your 

recorder, as configured in ExtenDOS 4. Only the drive letters 
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corresponding to available recorders are selectable. Note that if 

no recorder drive letter is selected, or if the selected recorder is 

no longer available, CD InScriptOr will automatically select the 

first recorder available. 

Info: Click this button to display information about the selected 

recorder. 

Speed: Selects the default recording speed that you want to 

appear in the Write dialog box. 

Enable burnproof recording: There are three possible 

states for this box: 

1 .  If greyed out and the box is deselected, your recorder doesn't 

support burnproof. 

2. If greyed out and the box is selected, your recorder supports 

burnproof and it is always on; it cannot be turned off. 

3. If not greyed out, your recorder supports burnproof, and you 

can turn it off by deselecting this box, and turn it on by 

selecting it. Note that for DVD+R, burnproof is always on, 

regardless of this setting. 

The burnproof feature prevents errors due to the recording speed 

being too high for your system (this type of error is also known 

as a buffer underrun). The drive will wait for data if it can't 

receive it fast enough from the system. All DVD recorders that 

we know of provide this feature; it is also available on current 

CD recorders. 

However, although by using the burnproof feature you can set a 

very high speed without causing a write failure, too high a speed 

will actually slow the overall recording throughput because the 

drive must constantly stop and start. The optimum speed is 

normally the highest speed that you can set without needing 

burnproof, or the lowest speed that needs burnproof. 

By default, CD InScriptOr enables the burnproof feature if 

available on your drive. We suggest always using it when 

available, especially with DVDs as even a 1 X  DVD speed may 

be too fast for your system. It can also be useful when writing to 
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CDs since, with current drives, you often can't select a low 

speed. 

Choosing the Image drive 

In the row labelled Image, choose which partition will be used 

to contain the image file. You will normally have the best results 

if you select the fastest drive, but the partition must have enough 

free space for the largest session that you want to put on the disc. 

If you're not sure which partition has the most free space, click 

on the Calc. button. All your hard disk partitions will be 

scanned, and the partition with the most free space will be 

automatically selected as the image drive. 

How to create a CDextra disc 

A CDextra disc is basically a multisession CD with the first 

session being an audio session, and the second and subsequent 

sessions being data sessions. 

To create a CDextra disc, first use CDwriter to create a 

compilation as usual. Keep in mind that you must leave some 

space on the CD for the data session(s). Then, in the Write dialog 

box, check the box Close for CDextra before writing. 

After the CD is created, it can be used as a normal audio CD, but 

it is in fact a multisession CD to which you can add data tracks, 

as follows. Using CD InScriptOr, create a session with the files 

you want to put on the CD extra disc. Before writing the data, 

check the box Don't include previous session in CD 

InScriptOr's Advanced Options window. 
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Other features 

CD/DVD information 

You can show information about a 

disc. Under the CD/DVD menu, 

choose Info, or press Control-I on 

the keyboard. 

The information is:  

 Type of disc 

 Free space 

 Used space 

 Number of sessions 

 Additional filesystems (Joliet, Rock Ridge) present, if any 

Make image file 

You can create an image file without automatically writing it to a 

disc at the same time. Under the menu Session choose Make 

image file.... This will bring up a file selector allowing you 

to choose both the location and name of your image file. Long 

filenames are supported. To subsequently write the image file to 

disc, check the From image checkbox in the Write dialog box 

(see page 3). 

Erase CD 

You can erase a CD-RW or DVD-RW disc. Under the CD/DVD 

menu, choose Erase.... For a CD-RW, you may choose 

between Full and Quick: a full erase erases the entire disc; a 

quick erase erases just the first session. A quick erase is always 

quicker (sometimes a lot quicker) than a full erase. A progress 

bar is displayed during the erasing process and the mouse shape 

turns into an eraser. 
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In most cases, a quick erase is sufficient; however, in rare cases 

you may need to use a full erase to prevent previously-recorded 

sessions of a multisession disc from "re-appearing". 

CD InScriptOr does not support quick erase for DVD-RWs. A full 

erase is always performed. 

Save window positions 

This feature is found under the Options menu. Choose Yes to 

save the current window screen positions. The most recent 

positions of closed windows are also saved. The positions are 

saved in the file CDISO.INF. 
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Annex 1 - Operating limits 

Maximum ISO9660 name length  31 characters 

Maximum Joliet name length  64 characters 

Maximum Rock Ridge name length  128 characters 

Maximum path length  1024 

characters 

Maximum image file size  2 GB 

Maximum session size  2 GB 

Maximum number of ISO9660 

folders 

 65535 

Maximum number of Joliet folders  65535 

Maximum number of items displayed 

in session window 

 1000 

Maximum number of items in 

session 

 Unlimited 
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Annex 2 - Exclusions syntax 

Rules for filename pattern matching, for the Exclusion Options 

dialog. 

1. ? matches any character (including .); for example: 

  pattern abc?x 

matches: 

abcax 

abcXx 

does not match: 

abcx  

abcaxy 

 

2. matches any character string of zero or more characters 

(including .); for example: 

pattern ab*ef 

matches: 

abef 

abc.Def 

abczzzzzzzzzzzzzzzzzzzzzz

ef 

does not match: 

abf 

abcDefg 

 

3. You may specify a list of single characters that match in a 

given position by including the list in square brackets; for 

example: 

 pattern ab[XxYZ] 

matches: 

abX 

abZ 

does not match: 

abz 

abXY 

But note that if you want to include ! or ^ in the list of 

matching characters, you cannot put them immediately after 

the [ because of rule 4 below. 
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4. In (3) above, if the first character following the [ is ! or ^, it 

indicates that the list is a list of characters which must not 

match; for example: 

pattern [!Aa]jkl 

matches: 

Bjkl 

xjkl 

does not match: 

Ajkl 

ajkl 

bjk 

 

5. If you want to use ? * [ or ^ as a 'normal' character in the 

pattern string (rather than it having a special meaning), you 

can precede it by the escape character ^; for example: 

 pattern ab^*ef 

matches: 

ab*ef 

does not match: 

abcdef 

ab^cef 

pattern ab^^*ef 

matches: 

ab^ef 

ab^xxxxxef 

does not match: 

abdef 
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